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PHI Safety Notices

Physical Electronics’ (PHI’s)
products are designed and
manufactured in compliance
with accepted worldwide
practices and standards to
provide protection against
electrical and mechanical
hazards for the operator and
the area surrounding the
product. All PHI products are
designed and intended for
professional use only, by
skilled “operators” for their
intended purpose and
according to all of the
instructions, safety notices,
and warnings provide by PHI.

Those instructions, notices,
and warnings assume that an
“operator” will not employ any
tool when using PHI products.
They further assume that all
operators clearly understand
that use of PHI products in any
manner not specified by PHI
may impair the protection
provided by the products and
expose them to hazards.

A “technician” is a qualified
servicing individual who:

• Has received training to
work with voltages above 50 V,

• Has read and understood
the PHI technician’s manual
for the equipment,

• Observes and under-
stands all safety notices on
PHI equipment.

The safety symbols that PHI
uses are defined on the
following page.* To reduce or
eliminate hazards, technicians
and operators of this
equipment must fully
understand these symbols.

PHI’s products are installed
with international-style or
ANSI†-style safety notices,
according to site
requirements. International
notices are symbols within
triangles (alerts) or circles
(mandatory actions). PHI’s
ANSI-style safety notices
contain:

• One of three signal words
(in all capitals) preceded by the
general danger symbol ( );

• One of PHI’s safety symbols
along with a brief description of
the hazard and the risk or injury
that could occur;

• Short message that
observes ANSI’s Hazard Alert
Trilogy Rule by identifying the
hazard, the possible result of
ignoring the notice, and how to
avoid the hazard.

The three signal words are
defined as follows:

• DANGER—imminently
hazardous situation that, if not
avoided, will result in death or
serious injury;

• WARNING—potentially
hazardous situation that, if not

 avoided, could result in death
or serious injury;

• CAUTION—potentially
hazardous situation or unsafe
practice that, if not avoided,
may result in minor or
moderate injury or damage to
equipment.

SEMI‡ standards require
identification of type 3, 4, and
5 electrical maintenance tasks
in equipment manuals:

• Type 3 electrical
maintenance tasks involve
energized equipment,
exposed live circuits, and
possible accidental contact;
potential exposures are less
than 30 V RMS, 42.2 V peak,
240 V-A, and 20 J.

• Type 4 is the same but
potential exposures are greater
than 30 V RMS, 42.2 V peak,
240 V-A, and 20 J or radio
frequency is present.

• Type 5 tasks involve
energized equipment and
measurements and
adjustment require physical
entry into the equipment, or
equipment configuration will
not allow the use of clamp-on
probes.

Only experienced, trained
technicians should attempt to
perform type 3, 4, or 5
electrical maintenance tasks.

* Many of PHI’s safety symbols are provided and copyrighted by Hazard Communication Systems, Inc., Milford, PA.

† American National Standards Institute, 1430 Broadway, New York, NY 10018.

‡ Semiconductor Equipment and Materials International, 805 E. Middlefield Rd., Mountain Vie w, CA 94043-4080.
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Voltages may be present that
could cause death or

personal injury.

A risk of death, personal injury,
and/or damage to equip-
ment exists (and a more

specific label is
not available).

Pulling the plug from its power
source before servicing

is mandatory.

A pinching point is present that
could cause personal injury.

A risk of explosion or implosion
may be present that could

cause personal injury.

Lifting with assistance or
equipment could cause

personal injury.

Visible or invisible radiation may
be present that could cause

personal injury.

Hot surfaces may be present
that could cause
personal injury.

Turning off the power switch
before servicing is mandatory.

Refer to the manual(s)
before proceeding.

Contents are under pressure.

A harmful or irritant material may
be present that could
cause personal injury.

Extremely low temperatures
may be present that could

cause personal injury.

A potentially dangerous
magnetic field may be present.

Wearing protective gloves
is mandatory.

Wearing eye protection
is mandatory.

Wearing foot protection
is mandatory.

This is the location of the
protective grounding
conductor terminal.

This is the location of the fuse.

This is the location of an earth
(ground) terminal.
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Limited Warranty

Except as otherwise provided herein, the Seller
warrants to Buyer that the equipment sold
hereunder, whether it is new equipment or
remanufactured (reconditioned) equipment, is, at
the time of shipment to Buyer from Seller, free
from defects in material and workmanship.  As
Buyer’s sole exclusive remedy under this
warranty Seller agrees either to repair or replace,
at Seller’s sole option and free of part charge to
Buyer, any part or parts of such equipment
which, under proper and normal conditions of use
prove to be defective within 12 months from the
date of receipt by the Buyer.  Warranty period for
equipment requiring installation by Seller will
commence on completion of standard installation
services.  If customer delays installation beyond
45 days after delivery, the warranty period will
commence to run 45 days after delivery.  After
installation, any realignment, readjustment,
recleaning or recalibration, provided it does not
relate to a proven defect in material or
workmanship, shall be performed only at Seller’s
then current rates for service.

Exclusions and Limitations
It is recognized that some parts by their nature
(expendable items) may not function for one full
year; therefore, excluded from the foregoing
warranty are filaments, anodes, cathodes,
multipliers, retard grids, special ceramics,
ionizers, along with other such parts mentioned
in the applicable operating manual.

The foregoing warranty excludes certain major
items or accessories specifically indicated on
applicable price lists or quotations, as to which
Seller passes to Buyer whatever warranty is
provided to Seller by the manufacturer or the

specific warranty indicated by the price list or
quotation.

This warranty does not cover loss, damage, or
defects resulting from transportation to the
Buyer’s facility, improper or inadequate
maintenance by Buyer, buyer-supplied software
or interfacing, unauthorized modification or
misuse, operation outside of the environmental
specifications for the equipment or improper site
preparation and maintenance.

Product Service
All claims must be brought to the attention of
Seller within 30 days of the failure to perform.

Seller at his option may require the product to be
returned to the factory, transportation prepaid, for
repair.

Refund of Purchase Price
In lieu of the foregoing, Seller may at any time
elect, in its sole discretion, to discharge its
warranty by accepting the return of such
equipment and refunding any portion of the
purchase price paid by Buyer.

Software and Firmware Products
The sole exclusive warranty applicable to
software and firmware products provided by
Seller for use with a processor will be as follows:
Seller warrants that such software and firmware
will conform to Seller’s program manuals current
at the time of shipment to Buyer when properly
installed on that processor.  Seller does not
warrant that the operation of the processor
software or firmware will be uninterrupted or
error free.

No other warranty is expressed or implied.  Seller expressly disclaims the implied
warranties of merchantability and fitness for a particular purpose.
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Section 1:
Introduction

This manual begins by discussing the hardware, startup and software user
interface of the Physical Electronics’ Quantum 2000 Scanning ESCA
Microprobe System.  (Note, Physical Electronics is also known as PHI.)
Read this section before logging into your Quantum’s workstation.  The last five
pages of this section detail logging into the workstation and starting the Physical
Electronics software.  For general instructions on how to

• insert, remove and move sample platens, see Section 2.

• locate analysis positions, see Section 3.

• setup COMPASS menus to acquire data, see Section 4.

The manual then diverges and begins examining the different modes or types of
acquisitions (Section 5).  Although each subsection concentrates on acquiring and
reducing data, special considerations for mounting, introducing and locating
analysis areas on samples is also reviewed.  The manual ends with an explanation
of a few of the Sun Operating System Tools (Section 6).
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Hardware Overview

Figure 1-1. Photo of a standard Quantum 2000 System showing the sample introduction door and
electronics bay on the system’s front side along with operator’s table and peripheral
computer equipment.  Your system may be slightly different, depending upon the options
ordered.

Above is a photo of the Quantum 2000 Scanning ESCA Microprobe.  Modeling a
different design concept from our previous generation ESCA systems, the
Quantum 2000 has no visible ports or flanges.  Functionally, the Quantum
system is split in two:  the left half of the system houses the vacuum chamber,
while the right side contains all of the electronic controls.  From the front of the
console, the door for the sample introduction chamber and an electronics bay are
visible.  The Quantum’s automated sample handling capabilities facilitate high
throughput and unattended analysis.
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Figure 1-2. View of the optics inside the vacuum chamber

All the X-ray and electron optics are behind the panels on the left side, inside the
vacuum chamber.  The Quantum 2000 uses a precision optics block enclosed
inside the vacuum chamber to facilitate alignment of the optics.
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Figure 1-3. The COMPASS Start/End Page Banner with a picture of the electron to x-ray path to the
sample.

A strength of the system is the ability to image features as small as 10 microns in
diameter.  The Quantum 2000 uses a small diameter electron beam to generate an
x-ray beam of less than 10 microns in diameter.  Scanning the electron beam
provides ESCA imaging capability.
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Operator’s Table Equipment
The data system and its peripherals sit on the table beside the system.  This
equipment includes a Sun Workstation, a video monitor, a print system for
printing in both black and white and color, and a tape drive.

The Sun Workstation is configured with a tape drive for backing up data on the
hard disk and mass data storage.  For black and white output, use the high-
resolution, 1200 dpi, laser printer.  You will hear the laser printer warming up
periodically, when it is trying to maintain temperature.

A video monitor allows initial viewing of images as they are collected. You can
view optical images, secondary images, and elemental images on this monitor as
they are being collected. Once those images are collected, they are  typically
"grabbed" by the Sun and brought into the COMPASS software for use in
defining analysis positions.

Figure 1-4. 3-D view of the Quantum 2000.  The small box to the far left is the roughing pump. On
the upper shelf of the operator’s table, from left to right, are the video monitor, the Sun
workstation monitor, and the black and white and color printers stacked together.  The
Sun workstation computer is shown to the left of the keyboard on the table top.  Note,
your system’s printer configuration may differ.
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Electronics Bay
The electronics bay or tower is located to the right of the sample introduction
door.  The electronics bay includes two core card racks, hidden behind brown
panels above the exposed brown electronics controls.  (See Figure 1-5.)  The card
racks contain the boards that run most of the optics in the system.

Below the card racks in the exposed electronics section, the first controls are two
vacuum gauges that sense pressure in the introduction chamber and in the main
chamber.

The ion gun control is below the vacuum gauge controls.  There are two possible
ion gun controls for the Quantum 2000.  The Model 11-085 ion gun control
operates manually, but can be turned on and off by the computer for sputter depth
profiling.  The software interface controls all voltages in the Model 11-066 ion
gun control.

Next, the Model 11-420 Electron Beam power supply runs the electron gun that
forms the X-ray beam. The 11-420 is completely computer-controlled (no manual
buttons or knobs).   The bottom control in the electronics tower is usually the
high-voltage ion pump control (either a DIGITEL 1500 or a DIGITEL
MPC).  The ion pump control supplies high voltage to the ion pump elements and
monitors ion pump current and voltage.

Figure 1-5. Front View of Console with Electronics Bay
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Figure 1-6. Core Card Rack
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The end panel farthest from the sample introduction chamber’s door and adjacent
to the electronics bay contains a personal computer that controls all the hardware
in the system. This computer acts as an interface between the Sun Workstation
and the electronics in the system. Beneath the computer are a cooling fan and the
heat exchanger, which holds water to cool the X-ray source anode.

Figure 1-7. End View of the Console showing the Embedded PC
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Table 1-1. Boards Installed in the Embedded PC

Slot No. Function Part No.

1 Blank

2 Blank

3 RS232 627473

4 SCSI Interface 624146

5 SCSI Interface Connector Bracket

6 Analog Out DDA 06 626566

7 Analog In DAS 1402 626565

8 Blank

9 Motion Control 629459

10 PIO-24 631800

11 486 CPU/Disk Controller 626822

12 Frame Grabber 626457

13 Video Board 626847

14 Blank

15 Model 258 Dr11 631870

16 Blank

17 FLASH Electronics 626553

18 MACH 8 625663

19 MACH 8 625663

20 Blank
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System Options
The Sample Positioning Station (SPS) option is used to locate small features on
samples, which are difficult to see either with the Quantum’s platen photographs
or in the SXIs (secondary electron images).  The SPS System uses a higher
magnification optical microscope to view samples.  SPS images can be viewed
on the SPS computer and can be transferred via a computer network connection
to the Sun workstation for analysis position definition.

Figure 1-8. Sample Positioning Station from left to right: positioning station, light source power
supply, X and Y digital encoders, and computer system.

Other options include

• Introduction Ion Gauge and Control,

• Auxiliary Port Interface,

• Additional Sample Carriers,

• Hot/Cold Stage, and

• Cold Introduction Chamber.
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System Power and Emergency Off
The Quantum system is typically on 24 hours a day and not powered on and off
daily.  On the back of the system is a circuit breaker panel.  The individual circuit
breakers within allow major segments of the console to be turned off for
servicing purposes.

Figure 1-9. End View of Console showing the Circuit Breaker Control Panel

In the event of a hazardous occurrence or emergency, the system can be shut off
using the Emergency Off button on the front panel.  Depressing that button will
disconnect all electrical power to the system.  Do not use the Emergency Off as
an on and off button, but only as a true emergency button. For the purpose of this
instruction manual, we will assume that the system is on.
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Figure 1-10. Front View of Console with Emergency Off Switch to the right of the electronics bay
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Figure 1-11. Top View of Console with Core Power Supply and Main Power labeled.

Power Interruption
In the event of a power interruption, the system console will recover
automatically under the control of its embedded PC and begin to turn on pumps
and valves that are necessary to maintain vacuum.  In the SUN workstation, it
will be necessary to restart the software.

Shutting down the Optics
Three electron optics devices in the system use hot filaments: the electron gun,
the ion gun, and the neutralizer.

The electron gun’s electron beam generates X-ray beams when the electron beam
strikes the anode. The electron gun has a LaB6 filament that is typically left on all
the time to maintain thermal stability.

The ion gun has a tungsten alloy filament and may be shut off daily.  If you
anticipate using the sputter ion gun, Physical Electronics recommends that you
turn it on shortly before it is needed to allow it to warm up (15 minutes).

There are two ion gun control models.  For the 11-085 ion gun control, the
filament shutoff is on the front panel.  Turn the emission control counter-
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clockwise to bring the emission current down to 0.  Then, shut off the 11-085’s
main power switch.  The 11-066 ion gun control is computer-controlled through
the software.  In the ion gun menu, set the gun to off to shut it down.

To improve the neutralization capabilities of the Quantum 2000, the original
neutralizer, which used a tungsten alloy filament, has been replaced with a newer
model that uses a cold cathode emitter.  Physical Electronics recommends
shutting the neutralizer off at the end of the day.  The software controls the
neutralizer with choices of On, Off, or an Auto(matic) Mode.  The Auto mode
turns the neutralizer on at the start and off at the end of an acquisition.
Associated with the earlier neutralizer is a deflection control box, which can be
left on all the time.

Daily Shutdown
At the end of the day, shut off the neutralizer and the ion gun unless you are
performing unattended analysis.  The COMPASS Software will automatically
turn off the 11-066 ion gun control and the 72-085A neutralizer control if they
have not been used within the operator-defined length of time.
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Assumptions
Note:  Items in bold-italics are performed by Physical Electronics personnel
either before shipping the system or by the Physical Electronics service engineer
at the customer site.

The power is on in the main part of the console, and the embedded PC is running
the system normally.

Gas lines (dry nitrogen and compressed air) have been connected.

The SUN workstation, monitor, keyboard, mouse, external hard drive,
printer and serial communications cable (from the SUN Workstation to the
embedded PC) have been connected.  Any necessary network connections
should also be setup.

All software has been fully installed
—on the embedded 486 PC:

• MS-DOS

• TSX-32 OS

• Physical Electronics’ embedded PC Software

—and on the Sun Workstation:

• SPARC

• NeWSprint

• Physical Electronics’ COMPASS Software

• Mathworks MATLAB

• Physical Electronics’ MultiPak Software

The computer and monitor are on and showing the log-in prompt.

All optics and the sample handling apparatus have been aligned and are in good
working order.

Note:  All MultiPak functions are described for a Sun Workstation and not for a
Personal Computer.
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Desktop
This discussion begins with a definition of what a screen and a desktop are.
Windows and menus are then described.   Then the parts of a window-menu are
described.   The last part of the discussion details using the mouse and cursor
within the SUN Operating System and the Physical Electronics’ COMPASS and
MultiPak softwares.

Screens and Desktops
The screen is the entire viewing area of the monitor.  Desktops are associated
with software packages and usually take up the entire screen area.  A software
package’s desktop will obey consistent rules for input and output of information,
such as, using pop up or pull down menus, requiring Returns or mouse clicks,
and color codes.

Windows, Menus, and Icons
Each program or part of a program runs in a bordered area or WINDOW on the
screen.  The word MENU is used to describe each Physical Electronics
COMPASS or MultiPak Software window.  Selecting one of the Main Control’s
Analysis Flow Diagram icons can open multiple windows or menus on the SUN
desktop.

If a program is on the screen but not running in a window, then it is usually an
icon.   An icon is a representation of the program or window.  When a program is
iconized, the program is open but is not available for input.  Users iconize
programs when they still have a need for a program, but currently need more
viewing space or wish to have an orderly, uncluttered desktop.  Select the icon
button in the menu’s title bar with your left (SELECT*) mouse button to iconize
the menu.

The SUN window manager defines a default size for the window or menu.
There is no automatic window or menu size that’s defined by the Main Control
menu.   If you change the view or move the window, the window will remain the
same size.  Any window can be made to be full-screen height by

• double clicking with the left mouse button on the title bar or

• positioning the cursor on the title bar, pressing the right mouse button, and
then selecting Full Size from the Window menu.
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Double clicking again, selecting the Enlarge Window icon , or clicking on
the Title Bar with the right mouse button to display the Window menu and
selecting Restore Size will all return the menu to the standard size.

The menus have been positioned so that the commonly used parameters are
visible.  The "Properties" submenus usually contain infrequently used
parameters.  In some situations, windows or menus may be partially covered or
masked by another window.  To display the entire window, click on the
window’s title bar or border.

Every COMPASS Menu Bar includes an Exit button, which will close the menu.
If you select Exit, the window will close and be taken off the screen.  Use the
Analysis Flow Diagram window manager within the Main Control menu to open
and close windows.  (See the section entitled Analysis Flow Diagram.)
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The Parts of a Window or Menu
Physical Electronics COMPASS and MultiPak menus or windows differ in
format.  This section includes an example of each with definitions of terms.

Figure 1-12. The parts of a typical COMPASS menu.

Title Bar: The top bar running across a menu.  The Title Bar includes the menu

title name and a Window Control , an Iconize and an Enlarge Button.  Press
the Iconize button to iconize the menu.  By selecting the Title Bar with the right
(MENU*) mouse button, the Window menu will display.

Menu Bar: Located underneath the title bar, the Menu Bar contains a list of pull-
down menus.
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Figure 1-13. The parts of a typical Physical Electronics MultiPak menu.

Upper and Lower Toolbar or Push-button Row:  The MultiPak Upper and Lower
Toolbars are examples of push-button rows. To activate a push-button, just
position your cursor on a push-button and press the left (SELECT*) mouse
button.  Selecting a function from the Menu Bar or Upper Toolbar will cause new
pushbuttons to display in the Lower Toolbar and change the menu title.

*See SUN Operating System (OS) Mouse Functions discussion.

Note:  All MultiPak functions are described for a Sun Workstation and not for a
Personal Computer.
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Cursor and Mouse Functions

Cursor
The cursor or pointer is often in the shape of an arrow pointing to the upper left
(see image below).  The cursor reflects any movement of the mouse.

Figure 1-14. When the computer is processing information, the cursor often changes shape to an
hourglass, watch, or, in MultiPak, an arrow pointing to the upper right.  No keyboard or
mouse entries are accepted during this processing period.

SUN Operating System (OS) Mouse Functions

Left Mouse Button = SELECT
The left or SELECT mouse button is the most frequently used button. Use the
SELECT button to highlight (select) items and pick menu parts, such as corners
for resizing or title bars for moving the menu location. Click and Drag, Hold and
Drag and Double-clicking are all techniques used with the SELECT button.

Middle Mouse Button = ADJUST
For example, when selecting variable-sized Regions in Snapshot, a line at the
bottom of the dialog box prompts you to "SELECT—Position Rectangle
ADJUST—Snap Image."  This means first click and drag the SELECT button to
outline the desired region.  Then move the cursor outside the selected area and
press the ADJUST button to activate the snap.  The COMPASS Mouse Functions
(next section) includes more discussion of the Click and Drag technique.
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Right Mouse Button = MENU
To choose a pop-up menu item, position the cursor and press the MENU button
to see the available options.  The menu that displays depends upon the cursor
position.  For example, when you position the cursor within or on

• the titlebar, the Window menu displays.

• the desktop, the Workspace menu displays.

• a Terminal Emulator Window (command entry window), the Term Pane
menu displays.

To choose a menu item, you must continue holding the right mouse button as you
move the cursor to the menu item.  Releasing the MENU (right) button selects
that menu item.

COMPASS Mouse Functions
In the COMPASS™ Software, the LEFT mouse button is the SELECT button.
Click or double-click this button to select or highlight items.

The MIDDLE mouse button is the DRAG button.  Press the middle mouse button
down and move the mouse around when you want to reposition something
movable.  Releasing the middle mouse button fixes the object at this point.

To highlight entire text fields in the COMPASS Software, click the RIGHT
mouse button.

LEFT = SELECT, MIDDLE = DRAG, RIGHT = HIGHLIGHT

The Horizontal, Vertical and Box Cursors of the Spectral and Intensity
Viewer  Menus (COMPASS)

Selecting Zoom for Cursor: in a Viewer menu displays either the horizontal,
vertical or box cursor, depending upon what was selected for Zoom->Setup.

Two vertical lines that extend from the top to the bottom axes and joined at the
center by a crossbar make up the horizontal cursor.  The shape of this cursor is an
"H."  The vertical cursor consists of two horizontal lines that extend from the left
to the right axes joined by a cross bar.  The shape of the vertical cursor resembles
an "I."  A solid line box with cross hairs inside makes up the box cursor.  The
box cursor moves in both the vertical and horizontal directions.
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Box Cursor

Anchor and Grow

Horizontal Cursor: When the user presses the MIDDLE mouse button and drags
the mouse arrow across the plot, the left bar remains at the initial location of the
mouse and the right bar follows the mouse arrow.  When the user releases the
middle mouse button, the right bar is set in the new position.

Vertical Cursor: When the user presses the MIDDLE mouse button and drags the
mouse arrow across the plot, the top bar remains at the initial location of the
mouse and the bottom bar follows the mouse arrow.  When the user releases the
middle mouse button, the bottom bar is set in the new position.

Box Cursor:  Pressing the MIDDLE mouse button anchors the upper left corner
of the box at the location of the mouse.  Keeping the MIDDLE mouse depressed
while moving the mouse "grows" the box.  The lower right corner follows the
mouse movements and is fixed in place upon releasing the MIDDLE mouse
button.

You can no longer resize any of these cursors.  To change the size of your cursor
selection, start over by clicking at the desired location with the MIDDLE mouse
button.

Selecting Data for Cursor: in a Viewer menu displays a single line or bar
extending from the top axis to the bottom axis of the current plot.  A dialog box
also displays.  Use this cursor to find a) the maximum peak height (Y Max.
button), or b) the y-value of any coordinate by either dragging the cursor bar with
the mouse or by inputting an x-value into the X: text entry field.  (See also the
Cursor Sub Topic of the COMPASS Help files.)
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COMPASS Startup
To startup the COMPASS software on the SUN, log-in by typing “phiuser1” and
pressing Return.  Press Return again at the password prompt, since the software
is setup without password protection. The SUN Desktop will load and display
two windows on the screen:  a console window, which is iconized, and a
command tool window, where SUN commands can be typed.  Typically, you will
iconize the Command Tool window, unless you need to perform some task on the
SUN.  Iconize the Command Tool window by clicking with the left mouse button
once on the Iconize button in the title bar.

To start the Physical Electronics software, position the cursor in an open area of
the SUN Desktop.  Press the right mouse button to display the Workspace Menu.
From the newly displayed menu, select COMPASS.  The COMPASS Software
will begin to load.  On the screen, a message will display stating that the
computer is starting the current version of software.   The Physical Electronics’
Main Control Menu with title bar, menu bar and Analysis Flow Diagram will
display on the desktop.

Figure 1-15. Main Control Menu with Analysis Flow Diagram visible, flowing to the right.

The Physical Electronics COMPASS software runs in a windowed environment.
The Analysis Flow diagram acts as a window or activity manager for Physical
Electronics Software.  Selecting one of the buttons in the Analysis Flow diagram,
with the left mouse key, will open the necessary COMPASS windows to perform
that task.  The Analysis Flow diagram has a button for each of the major tasks
normally performed in an ESCA Analysis: introducing a sample, locating
analysis areas, acquiring data, and removing the sample.
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Each of these icons is discussed in the listed sections.

Table 1-2. The five icons or steps that divide the data acquisition process

Icon Section No.

Intro. Sample 2

Locate Areas 3

Acquire Data 4 and 5

Remove Sample 2

Figure 1-16. Locate Areas Icon

Selecting an icon from the Flow Diagram displays the menus needed to complete
that step. For example, selecting the Locate Areas icon displays the Platen View
and the System menus.

Main Control Menu Bar

Figure 1-17. Main Control Menu Bar

In the Main Control’s menu bar are several pull-down menus.

The first pull-down, Menus, allows direct access to all the COMPASS menus.
The menu categories are Acquisition, Console, Main Control and Optics.

The Work Space pull-down menu allows users to customize their work spaces by
sizing and positioning the menus they want displayed in each step of the Analysis
Flow diagram.

The Properties button opens the Main Control Properties menu, where you can

• set a Service Mode* password or

• change the Analysis Flow Diagram direction (for right to left reading) or turn
the AFD display off, or

• select options, such as, which ion gun control is used.
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The Exit button starts the process of shutting down the COMPASS Software.

* Some menus contain a Service Mode parameter that if turned on allows access
to hardware values and service settings.  You can set a password in the Main
Control Properties menu that prevents users without password knowledge from
changing service parameters.  However, do not open this menu or change the
password unless you have a need to do so.

Main Control Properties Submenu

Figure 1-18. Main Control Properties Submenu showing Ion Gun and Neutralizer Control selection
and EMSL Transfer option.

Before running analysis for the first time, make certain that your system
hardware options are setup correctly in the Main Control Properties Submenu.
Besides selecting your Ion Gun Control, you must select your Electron
Neutralizer Control model.  If you update the hardware in your system, you will
need to make the necessary changes in this menu.
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Section 2:
Introducing and Removing Samples

This section describes how to use the Console Control menu to introduce and
remove samples from the Quantum System.

Overview of Console Control Menu (Sample Handing Mode)

Figure 2-1. Console Control Menu (sample handing mode selected)

The primary function of this window is to allow you to move platens in and out
of the system.  Depicted in the upper right portion is the Prep(aration) Area,
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which is located outside the system, perhaps on a lab bench.  In the center is the
vacuum chamber with two parking positions for storing platens in vacuum, the
sample stage, and the arm.  The arm is a mechanical device used to move the
platens from one location to another.  Sample platens are depicted as square icons
that have a name across the center and are normally colored black.  To move a
platen to a new location, click and drag (using the left mouse button) the platen
icon from the current location to the desired new location.  When you release the
mouse button, a platen icon will appear at the desired new location in reverse
color view.  (The icon will have a black outline and a white fill.)  The original
platen icon will be shown moving through the system to the new location.  When
the platen reaches the new location, the icon will take on its normal appearance
(black fill).  The Quantum performs all the necessary mechanical movements and
vacuum operations required for the platen movement to occur.

Introducing a Platen
Once the samples have been prepared and mounted on a platen, it is a simple task
to move the platen onto the sample stage.  With the Console Control menu
displayed in the Sample Handling mode, click and drag the platen icon from the
Prep(aration) Area to the Sample Stage.  The Quantum will vent the Intro.
chamber and display a software prompt asking you to place the platen into the
Intro(duction) chamber.

Open the Intro. chamber door by pulling up on the handle.  Pick up the platen
with a gloved hand.  The platen should be oriented over the Intro. platen nest
with the two ceramic sockets facing the Intro. door.  Tip this front side of the
platen up and push the back side against the spring loaded bar at the back of the
Intro. sample nest.  Then drop the platen down into place on the nest and release
the tension.  The sockets at the front edge of the platen should engage the metal
balls at the front of the Intro. sample nest, locking it in place.  When the platen is
securely in place on the Intro. sample nest, lift up on the handle and close the
Intro. door.  Then press the OK button on the prompt that requested you place the
platen in the intro.

After you press the OK button, the Quantum will take over and perform all the
necessary steps to move the platen onto the Sample Stage.  The platen will
remain in the Intro. chamber until the pressure setpoint has been reached.  At that
time, the Arm will move the platen onto the Sample Stage.

During pumpdown in the Intro. chamber, a Platen Information window will
appear that has a place to enter comments associated with the platen.  At the top
of this window is a place to select platen type and to specify maximum Z height.
There are two platen types: Standard and AR.  All flat platens are considered
“Standard”.  The AR platen has a raised center section.
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For newer Quantum systems, the maximum Z-height for the standard platen
should be 28 mm and for AR platens—13 mm.  For earlier systems or earlier
systems with stage updates, the maximum Z height will be between 25 and 28
mm for standard platens and between 11 and 13 mm for AR platens.  The
purpose of these numbers is to restrict the movement of the sample stage in the
Z-axis to safe values.

During pumpdown in the Introduction chamber, a CCD camera will take platen
photos for use in navigating around the platen and defining analysis areas.  On
the Console Control menu, you can select either a Low Mag photo that views the
entire platen, a High Mag photo that focuses in the center of the platen (~6X), or
both.

Removing a Platen
To remove a platen from the vacuum system click and drag the icon for the
desired platen from the Sample Stage or Park location to the Prep(aration) Area.
The Quantum will perform all the necessary steps to bring the platen into the
Intro. (Introduction Chamber).  After venting the Intro., a software prompt will
appear on the Sun monitor asking you to remove the platen.  Lift the handle on
the Intro. door to open it and remove the platen.  Once the platen has been
removed and the intro. door closed, press the OK button on the prompt window.
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Section 3:
Locating Areas

This section first familiarizes the operator with the menus used in selecting
analysis areas and then discusses three techniques for locating or selecting
analysis areas.

Menu Overview
After introducing a sample platen and moving it onto the Sample Stage, the next
task is to locate analysis areas on the samples.  To begin this task, press the
Locate Area icon (using the left mouse button) in the Main Control menu.  This
will open two menus or windows:  Platen View and System (known at Physical
Electronics as the “System Bar”).
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Platen View

Figure 3-1. Platen View Menu

The Platen View menu allows us to view platen photos, SXIs (secondary electron
images), ESCA maps, and high resolution photos from the SPS (sample
positioning station).  Any of these images or photos can be used to define
analysis locations.  It is possible to define points, rectangular areas, or lines as
features for analysis.  The right-hand side of the menu tracks analysis positions
and their location on the platen.    To move around on the sample platen, there are
two software glyphs shown on Platen View photos.  Use the left mouse button to
drag the gold glyph across the photo to any desired analysis location.  After
releasing the mouse button, the stage will begin to move and bring that location
in front of the analyzer’s focal point as is depicted by the maroon glyph.  When
the sample stage has moved to the new location, the two glyphs will be on top of
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each other.  The size of the square box on the glyph is a depiction of the size of
the imaged area selected in the System menu for SXI imaging.

The Platen View’s menu bar contains four functions:  Properties, View Layout,
Registration, and Exit.

Pressing the Properties button in the menu bar opens the Properties sub menu.

Figure 3-2. Platen View Properties Sub Menu

The dimensions of the Standard Analysis Area used when defining an analysis
area on a platen photo may be viewed or changed in the upper portion of the
Platen View Properties sub menu.  In the center of the menu, you may view or
change parameters that determine the dimensions of the High Power Analysis
Area.  The X dimension is fixed at 1500Îm, and the Y is typically set between
200 and 500Îm.  The Gating is normally set at 0% for both X and Y.  Other
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semi-permanent parameters related to the collection of platen photos are
accessible in this menu, but are rarely changed.

The View Layout button opens a window that shows several options for
positioning the photos and images within the Platen View menu.  Select the
choice that best meets your needs.

The Registration button opens a menu that has the function of registering
(calibrating) high resolution optical photos from the SPS (Sample Positioning
Station), which is an optional accessory for the Quantum.

Pressing the Exit button closes the Platen View menu.

Below the menu bar and above the displayed photos in the Platen View menu is
another group of buttons:  Platen X, at Location:, Lo/Hi, x1/x4, Create:, and Add.
The left most button is a pulldown that allows you to select the photo of a
specific platen.  The software will, by default, display the photo of the platen that
was most recently moved to the Sample Stage.  The Lo/Hi button allows you to
choose whether to display the low (1X) or high (6X) magnification platen photo
collected in the Introduction chamber.  The x1/x4 button allows you to display a
platen photo at its standard magnification (x1) or at a software expanded (x4)
view of the platen photo.  You can combine the Lo/Hi and x1/x4 magnifications
to view the object at 24X.  Pressing the Create: button opens a pull-down list of
choices for defining the shape of analysis positions.  The choices include: point,
areas (rectangular), lines, and High-Power mode analysis areas.

On the right-hand side of the Platen View menu is a listing of analysis positions
and images associated with the currently selected platen.  Three columns of
information are shown: Acquire Selection, Point #, and Comment.  On the left is
an icon representing the analysis position or image, in the center is a number
assigned to the analysis position, and at the right is a comment and information
field.  A large number of positions may be defined.  An analysis position may be
considered Current, Active or Inactive.  The Current analysis position’s icon and
number will appear yellow on the menu.  Active positions (positions selected for
analysis) will have an icon that appears as a depressed button, and the icon and
position number will be green in color.  Inactive position icons (defined but not
included in the current analysis) will appear to "pop" or stand out.  The icon and
position number will be red in color.  After typing in each Comment, press Enter.
Using the scroll bar at the bottom of the comment field, it is possible to view the
coordinates of analysis positions and their dimensions.



3: Locating Areas

Quantum Operator’s Guide 3-5

Figure 3-3. The Analysis Position Information, Control and Comment portion of the Platen View
menu.  Point 7 is the current analysis position (noted by yellow).  Green signifies an
analysis position will be analyzed, while red analysis positions will not.

Below the listing of analysis positions on the right-hand side of the menu is
another group of software buttons.  The Mode button allows you to choose
whether the Sample Stage is in the Live or Still mode.  In the Live mode, the
stage will move when you move the gold glyph or select a different analysis
point. In the Still mode, you can move the gold glyph or define analysis positions
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at different locations and the stage will not move.  Pressing the Move Stage
button will cause the stage to move to the currently selected analysis position, if
you are in the Still Mode (this would happen automatically in the Live Mode).
Pressing the Clear Point button opens a pull down that gives you the choice of
clearing the current point or all points on the currently selected platen.  The Grab
Image button saves a copy of the SXI image that is being collected on the video
monitor and places a copy of the image in the Platen View menu.  Pressing the
Load button gives you the option of displaying previously stored SXI images,
ESCA maps, or SPS (Sample Positioning Station) photos in the Platen View
menu, which is used for defining analysis position locations.  Pressing the Clear
Image button gives you the option of clearing the current image or all images on
the currently selected platen.

Figure 3-4. The bottom right portion of the Platen View menu used to control stage movements and
to grab, load or clear images, points, maps and photos.
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System

Figure 3-5. System Menu
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The System menu contains buttons that provide direct access to each of the major
hardware functions of the Quantum.  In addition, the most commonly used
features of those menus are directly accessible in the System menu.  To open the
full menu for a particular function, press the menu name button for that function
on the System menu with the left mouse button.  The following functions of the
System menu are routinely used when setting up analysis areas:  File Name,
Sample Handling, Imaging, and, in some cases, the Neutralizer.

File Name
The current file name can be viewed directly from the System menu.  Pressing
the File Name button will open up a menu where you can select the data storage
directory. It will also allow you to define a file naming system for the data
including a fixed prefix and a numerical suffix that is automatically indexed up
one number for each data file that is collected.

Note:  Pressing the Directory button from the File Name menu will allow
you to select any of the currently defined directories.  To define a new
directory, you must use the SUN File Manager, which is described in the
SUN Tools section at the end of this manual.

Figure 3-6. File Name Menu
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Sample Handling
The Sample Handling menu allows you to view or change the coordinates of the
gold glyph or the current analysis position.  Direct access is given to all axes of
the Sample Stage.  Pressing the Sample Handling button will open the Sample
Handling menu, which contains this information plus an animated view of the
sample platen in front of the analyzer input lens.

Figure 3-7. Sample Handling Menu
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Imaging
Under the Imaging button on the System menu are buttons that provide direct
access to the most commonly used features of the Imaging menu.  They include
on/off control of imaging, a pulldown list of imaged area dimensions, the
imaging mode, an image clear button, a pulldown list of x-ray spot sizes, and an
Auto-Z alignment function.

Turning the imaging on starts the collection of an SXI image.  There are three
modes for collecting SXI images:  slow, fast, and total.  The slow and fast modes
display a new image with each frame.  The total mode is a signal averaging mode
that is used to enhance image quality.  Select a small x-ray spot size for SXI
imaging to enhance the detail of the images.  Prior to collecting an SXI image,
the sample must be positioned at the focal point of the analyzer or the “correct Z
height”.  Pressing the Auto-Z button will start an automatic routine that will find
the focal point of the analyzer by examining the sample count rate at a series of
Sample Stage Z values or heights.  Physical Electronics recommends that a larger
x-ray spot size (20Îm or greater) be used for Auto-Z measurements to improve
the accuracy of the measurement.

When collecting SXI images from insulating samples, it may be necessary to use
the neutralizer to balance the surface charge and improve the quality of the
image.  If your system has the new electron neutralizer, use the standard
neutralizer conditions and select On or Auto to turn on the neutralizer during SXI
imaging.  If your system has the earlier tungesten filament neutralizer, select the
pulsed mode of operation for the neutralizer, set the energy to 20% and the
filament to 23mA.
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Figure 3-8. Imaging Menu
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Defining Analysis Areas on Platen View Photos

Figure 3-9. The Platen View Menu

When analyzing samples or features on samples that are large enough to see
directly from the Platen View photo, we can define analysis locations on the
photo and proceed immediately with analysis.  To select an analysis location,
click and drag the gold glyph so that the glyph’s box is centered on the desired
analysis area.  Then from the menu bar on the Platen View menu, select whether
you will define an analysis point, line, area, or high-power analysis area and
press the Add button.  Pressing the Add button will place the selected analysis
feature in the center of the area defined by the glyph.

Note:  The size of the box associated with the glyph is defined in the
Imaging portion of the System menu.  When adding rectangular analysis
areas to a Platen View photo, the size of the area is defined in the
Properties submenu of the Platen View menu.

After defining the desired analysis areas, you can proceed directly with acquiring
data.  It is not necessary to find the correct “Z” height for each sample. The Auto
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Z function can be activated as a part of the acquisitions, and the Quantum will
automatically align all the samples.

Defining Analysis Areas from SXI Images
If a feature is too small to identify from the Platen View photos, collect an SXI
image using a small x-ray spot size (typically use the minimum spot size).  The
SXI image will usually contain more detail than the Platen View image.

Note:  Prior to collecting an SXI image, position the sample at the focal
point of the analyzer using the Auto Z routine.  The depth of field of the
system is only a few hundred microns;  the image will be out of focus or
completely washed out, unless you are at the focal point.

With the sample positioned, use the glyphs and the Auto-Z routine to collect an
SXI image.  (The Total imaging mode is typically used.)  If you can not see the
feature of interest on the video monitor, move the sample using the gold glyph,
press the Clear button after the motors have shut off to clear the current image
and collect an image from the new area.  Continue this process until you find the
feature of interest.  You can change the field of view of the SXI image using a
pulldown list in the imaging portion of the System menu.

After obtaining an SXI that contains the feature of interest, press the Grab button
in the Platen View menu.  A copy of the SXI will be saved and displayed in the
Platen View menu.  Using the middle mouse button, click on the feature of
interest to define an analysis point, area, or line.  The choice of point, area, or line
is selected from the menu bar in the Platen View menu.  After defining all the
desired analysis areas, you are ready to acquire data.
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Figure 3-10. The Platen View Menu with high magnification platen photo and SXI Image displayed.
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Defining Analysis Areas from SPS Photos
The SPS (Sample Positioning Station) is an optional accessory for the Quantum.
Its purpose is to aid in the locating of small features that are not easily visible in
SXI images by providing high magnification optical photographs from any area
of the sample platen.

We will assume the SPS has been properly installed and calibrated, and you have
read the SPS manual.  If this is not the case, please refer to the Sample
Positioning Station manual (Part No. 634945) for instructions in use, calibration,
and installation.

To effectively use the SPS, capture and save photos from three features.  The
three features are the feature of interest (that may not be visible in an SXI image)
and two reference marks or features that will be easily seen in SXI images.  The
two reference marks will be used to Register or calibrate the SPS photos to match
the actual location of the samples on the platen.

Once the photos have been captured, they should be saved to the SUN
workstation computer via the SPS computer using the high resolution photo
directory destination path [typically E: /usr/datafiles/hrphotos where E:/
represents an exterior drive (the SUN Workstation) that is networked to the SPS
Computer].

1. Prior to registering the photos, press the Registration button on the Platen
View menu and enter 0 (zero) for the three correction constants.

2. Then load the photos using the Load button at the bottom of the Platen View
menu.

3. Select a photo from the list in the Platen View menu that contains a reference
point.  The stage will move to this point.

4. Then perform an Auto Z and collect an SXI from this area.  The reference
feature should be visible in the SXI.

5. Next using the left mouse button, define an analysis point on the reference
feature in both the photo and the SXI.

6. Repeat this process for the second reference feature.

7. After defining analysis points for both features on both the photos and SXIs,
open the Registration submenu by pressing the Registration button in the
menu bar of the Platen View menu.  Then enter the point numbers for the two
matching features from the photos and SXIs.
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8. After entering the position numbers, press the Register button in the
Registration dialogue box.  The software will calculate and display the offset
values necessary to register the photos.  When finished, press OK.

Note:  During your selection of reference points on the photos and SXIs,
the software compares the distance between the two points on the photos
and the same two points on the SXIs.  If the distance is different by more
than 5Îm, the software opens a prompt window that will inform you of
the difference it has measured.  If this error is similar to or larger than
the size of the features you will be analyzing, you should repeat the
registration process and define the points more carefully.

Once the registration process is complete, you can define analysis points, areas,
or lines on the SPS photos using the middle mouse key and proceed with the
analysis.

Figure 3-11. Photo Registration Sub Menu
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Figure 3-12. Platen View Menu
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Section 4:
Data Acquisition Menus

After the analysis locations have been defined, the next task is to setup the
Quantum for collecting the necessary data.  To begin the data collection process,
press the Acquire Data icon in the Main Control menu.  This will open three
menus:  the Spectral Viewer, the Acquisition Setup menu, and the Element
Table.  All data acquisitions can be set up from these menus.

Acquisition Setup Menu

Figure 4-1. Acquisition Setup Menu—Short Menu selected

The menu bar of the Acquisition Setup menu has six functions or buttons that
relate to setting up data acquisitions:  Load File, Settings, Reset, Properties,
Long/Short Menu, and Exit.

Pressing the Load File button opens a file menu that allows you to load the
hardware setup file for a previous data acquisition.  These files have a *.hdr
extension.

Once the file is loaded, the detailed setup of the acquisition can be viewed or
changed using the “Long Menu” mode of the Acquisition Setup menu.

Pressing the Settings button opens a file menu that allows you to load a Setting
file to setup an acquisition.  For a task that will be performed repetitively,
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creating a Settings file will make it easy to set up the same analysis conditions
multiple times.

Use the Reset button to restore the Acquisition Setup/Control parameters to the
values displayed when you first entered the menu.

The Properties button is used to open the Acquisition Setup Properties menu.

Acquisition Properties Sub Menu

Figure 4-2. The Properties submenu allows the user to view or change a number of semi-permanent
parameters that have an impact on data acquisition.

A list of six features that have buttons to switch on or off is located in the upper
left corner of the Properties submenu.  The Viewer button is normally switched
on all the time, and the other buttons are off most of the time.  An exception
would be when you want an Auto Z alignment to occur before each acquisition.
Also, the analyzer aperture could be turned on for angle resolved acquisitions to
improve angular resolution.  For more detailed information about the Analyzer
Aperture, see the Enhanced SXI—Sputter Shutter section of this manual.
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In the lower, left-hand side of the Properties submenu is a list of values and
features that can be viewed or changed by the user before an acquisition.  Most
require no explanation.  If you change the value or status of one of these
parameters, the change will remain in effect until it is changed again in the
Properties submenu.  Target Base Time/Step is the default dwell time per data
point for a spectral acquisition and is typically set between 20 and 50 ms.

Several parameters refer to Pixels per Beam Width.  This parameter determines
how many data pixels will be used in collecting a specific piece of data.  For
example, if the Pixels/Beam Width was set to 1 (one) then for every beam
diameter width across the feature one data pixel would be defined.  Increasing
this number will increase the number of data points in an analyzed area.

Figure 4-3. From left to right respectively, 1 Pixel/Beam Width, 3 Pixels/Beam Width and 5
Pixels/Beam Width.  Note, increasing the number of Pixels per Beam Width increases the
area of the sample that is analyzed.

On the right-hand side of the Properties submenu is a list of parameters that
define the default values for the resolution or pass energy pull down in the
Acquisition Setup menu.  The left column has a text field where you can name
each resolution setting.  The center two columns are groups of pulldown list
buttons that are used to define the default pass energy and data step size for the
resolution settings.  The right most column labeled Ratio assigns a multiplier that
works with the Target Base Time/Step.  In an acquisition, the total time/step is
the Target Base Time multiplied by the Ratio number.  As the Pass Energy is
lowered, the Ratio is increased because count rate drops with Pass Energy.

Acquisition Setup Menu, Continued
The Long/Short Menu button is used to switch between the Long and Short form
of the Acquisition Setup menu.  The Long form of the menu provides access to
all parameters so they can be viewed or changed.  See figure on next page.

The Exit button closes the Acquisition Setup menu.

In the center of the Acquisition Setup menu are four buttons that are used to
define the type of acquisition that will be collected (acq. type, Time, resolution
setting, x-ray setting).  In the upper left is a pull down list (abbreviated menu)
that allows you to choose spectral acquisitions, sputter depth profiles, angle
profiles, lines, or maps.  In the lower left is a pull down list that allows you to
select the energy resolution (pass energy) with which to collect data.  In the upper



4: Data Acquisition Menus

Quantum Operator’s Guide 4-4

right is a text box where you can enter acquisition time, and on the lower right is
a pull down list where you can select the x-ray setting including spot size to be
used for the analysis.

Figure 4-4. Acquisition Setup Menu—Long Menu

In the body of the Acquisition Setup menu is a row of buttons that are used to
start and stop acquisitions.  The Refresh button starts an acquisition where no
signal averaging occurs (only the current sweep is displayed).  The Acquire
button starts a normal acquisition and signal averaging will occur if multiple
sweeps of data are collected.  The Stop button stops the acquisition at the end of
the next cycle and saves the data.  Continue will restart the acquisition if it has
been stopped and time remains in the defined experiment.  It is possible to extend
an experiment by increasing the time (for example, in spectral acquisitions) or
number of cycles (in the case of depth profiles) and pressing Continue.  Pressing
the Abort button stops the acquisition immediately and does not save the data.
Add to Queue adds the acquisition to a work list called the Queue.  A number of
acquisitions can be defined and added to this work list.  When the list is
completed, you push the Run button on the Queue menu to start the Quantum
working on the list.
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Element Table

Figure 4-5. COMPASS Element Table Menu—colored by transition group

Once you have determined the type of acquisition in the Acquisition Setup menu,
the Element Table is used to define what elements or spectral regions data will be
collected.  For each element in the Element Table, there is a listing of major
ESCA peaks and the most commonly used peak is selected as the default peak
(transition).  In addition to the elements, there is a row of 8 buttons that can be
set up as customized regions for survey spectra, valence band regions, etc.  To
select an element or custom region, use the left mouse button.  To set up a
multiple element acquisition, press multiple buttons.

Note: If you are setting up a customized region, the Transition Editor
requires an element symbol of one or two letters with the first letter
capitalized (such as Su for survey).  A transition name is also required
(such as Su1s for survey).  You will then need to enter the lower limit for
the region and its width in eV.  A sensitivity factor of 1 could also be
entered.

If you wish to customize an acquisition by changing the default parameters for
one of the regions or elements, select the Long form Acquisition menu, and you
will have direct access to all the parameters for each region.
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Figure 4-6. COMPASS Element Table Menu—colored by intensity (analyzer sensitivity)

If you wish to permanently change the default parameters for an element button,
press on the Acquisition Setup button in the Element Table tool bar and select
Transition Editor.  This will open a menu where you can change the default
transition or its parameters.  To make a permanent change, you must press the
Save button when you are finished.
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Figure 4-7. Transition Editor Menu

Note:  It is recommended that you do not permanently change sensitivity
factors for transitions.  If you should do so, record the original value so
that you can change it back when necessary.
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Spectral Viewer
The Spectral Viewer is where spectral data will appear during acquisitions.  If
you are acquiring data from more than one region, you can tile the display by
pressing the Settings button on the menu bar and selecting Load.  This will open
a File menu where you can select from one to eight spectral axes to be tiled for
display in the Spectral Viewer.

Figure 4-8. Spectral Viewer menu
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Enhanced SXI—Sputter Shutter (Analyzer Aperture)

Figure 4-9. Enhanced SXI Menu

The sputter shutter attaches to the side of the analyzer input lens.  It is normally
positioned so that it does not obstruct the path of photoelectrons into the
analyzer.  Under software control, the shutter can move in front of the analyzer
input lens.  The shutter has several purposes:

To protect the internal elements of the input lens during sputtering by physically
blocking sputtered materials from entering the lens.

To increase angular resolution during angle-resolved ESCA experiments.  The
shutter has a slit which decreases the input lens acceptance angle from Ù20 to Ù4
degrees.  Note:  Using the shutter to increase angular resolution causes
approximately a 3X reduction in the count rate of the data being collected.

To enhance the quality of SXI images, the opened shutter can be biased to
increase the collection efficiency of secondary electrons into the analyzer.

The Acquisition Setup’s Properties submenu controls the operation of the shutter.
In the Properties submenu, if the Analyzer Aperture option is not selected, the
shutter will be open for analysis and close during sputtering.  Selecting the
Analyzer Aperture option closes the shutter  for both analysis and sputtering.

The Enhanced SXI menu controls the operation of the shutter bias.  (From the
Main Control menu, select Menus -> Optics -> Enhanced SXI menu.)  There are
two modes of operation Auto On and Off.  Auto On is the recommended setting,
and this would turn on  the shutter bias only when SXI images are being
collected.
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Charge Compensation Systems after April 1997
This Charge Compensation section is for Quantum 2000 systems manufactured
after April 1997 (or earlier systems updated with the floating ion gun column, the
11-066 digital ion gun control, cold cathode electron neutralizer, and the 72-
085A neutralizer electronics).

When the Quantum’s x-ray probe strikes the surface of an insulating sample, a
positive charge is created by photoelectrons that leave the surface of the sample.
To neutralize this positive charge, a low energy electron flood gun or neutralizer
is an integral part of most ESCA systems.  Because the Quantum 2000 uses a
focused x-ray probe, this positive charge is localized to a small area where the x-
ray probe strikes the sample.  The remainder of the insulating sample typically
has a negative charge.  This negative charge is often large enough to deflect the
low energy electrons from the electron flood gun making it ineffective.  To
overcome this problem, the ion gun in the Quantum 2000 has been modified to
create an operating mode where 5-10eV ions are used to neutralize the negative
surface charge on insulating samples.

This dual neutralization capability is standard on Quantum’s shipped after April
1997 and earlier systems may be updated to this capability.  The hardware
associated with this improved neutralization capability includes a new electron
flood gun that uses a cold cathode filament with Model 72-085A electronics and
a modified ion gun column with 11-066 electronics.

The software menu for the electron flood gun (neutralizer) is shown in Figure 4-
10.  The values shown are typical for most systems.  The steering should be
adjusted with the use of the faraday cup, and it is recommended that this
alignment be done with the low energy ion neutralizer on.  At Physical
Electronics, we have found that high current (30uA emission) and low energy
(bias 1eV) will effectively neutralize most samples when used in conjunction
with the low energy ion neutralization capability.  PHI recommends the use of
the Auto mode.  This will turn on the neutralizer only when it is needed and
extend filament life time.
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Figure 4-10. Electron Neutralizer menu for systems with the 72-085A neutralizer boards.
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The low energy ion neutralizer should be used with ion energies between 5 and
10eV and ion currents of 20-30nA.  A menu with typical ion gun parameters for
low energy neutralization is shown in Figure 4-11.

Figure 4-11. Ion Gun Neutralizer menu for systems with 11-066 ion gun control.

The ion energy is the difference between the beam voltage and the float supply
voltage.  In the menu shown above, the ion energy would be 8eV.  The X and Y
offsets should be adjusted using the faraday cup.  Physical Electronics
recommends using the low energy ion neutralization in the Auto mode.



4: Data Acquisition Menus

Quantum Operator’s Guide 4-13

With both neutralizers properly setup and aligned, most insulating samples will
be effectively neutralized and there is no need for careful masking of insulating
samples.

Charge Compensation Systems Before April 1997
This section discusses charge compensation or neutralization for systems
manufactured before April 1997.  Pre-April 1997 Qauntum systems that have
been updated (with floating ion gun column, the 11-066 digital ion gun control,
cold cathode electron neutralizer, and the 72-085A neutralizer electronics) are
discussed in the previous section.

When the Quantum’s x-ray probe strikes the surface of an insulating sample, a
positive charge is created by the photoelectrons that leave the sample surface.
This charge can shift the position or distort the shape of ESCA peaks and blur
secondary electron images.  To eliminate this surface charge, a low energy
electron gun is used to neutralize the charge.

The neutralizer has two parameters that are controlled by the user.  The energy
controls the bias imparted to the electrons and is adjustable from 0 to 100%, with
100% equal to 10eV.  The second value is Emission Current, which is adjustable
from 0 to 25 mA.  With a properly calibrated neutralizer, you should operate the
emission between 22 and 24 mA.

There are two operational modes for the charge neutralizer, and the software
maintains a separate setting for each mode.

The SED (SXI) mode is used to neutralize the sample during the collection of
SXI images.  Since the neutralizer current would overload the secondary electron
detector, a pulsed mode of operation is used for neutralizing SXI images.  This
means the Quantum is alternately collecting data for the SXI and turning on the
neutralizer in a high speed pulsed mode.  Typical settings for this mode are
Energy: 20% and Filament: 23 mA.
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Figure 4-12. Neutralizer Menu for the 72-090 electronics—SED (SXI) Mode
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The Spectral mode is used for collecting all ESCA data.  In this mode, the
neutralizer is on continuously during ESCA acquisitions.  There are two modes
of operation: On and Auto.  The On mode turns on the neutralizer and leaves it
on until you turn it off.  The Auto mode automatically turns on the neutralizer at
the beginning of an acquisition and off when the acquisition is finished.  Physical
Electronics recommends the Auto mode to prolong neutralizer filament life.
Typical settings for this mode are Energy: 10% and Filament: 23mA.  For
samples that are difficult to neutralizer, it may be necessary to increase the
Energy setting to 15% or 20%.

Figure 4-13. Neutralizer Menu for the 72-090 electronics—Spectral Mode
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Sputter Ion Gun (Model 11-066 Control)

Figure 4-14. Model 11-066 Ion Gun Control Menu for COMPASS Software.

Through the software interface, the Model 11-066 ion gun control provides
complete computer control of the ion gun and all of its voltages.

The Operation Mode pulldown allows you to choose between the Neutralize
mode and the Sputter mode.  The Settings pulldown lets you select which sputter
setting you are going to use.  Names are defined in the Properties submenu.  A
typical 4 keV sputter setting is shown in the menu above.
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To optimize a setting, select the desired beam voltage and maximize the target
current from the ion gun with the Condenser, Grid Supply, and 5° Bend.  Then
use the faraday cup and adjust the X and Y offsets and Objective for maximum
current.  The emission current and raster size may be varied to change the sputter
rate.  When the setup is complete, save the setting.

To determine a sputter rate, it is necessary to sputter through a film of known
thickness.  1000 angstrom thick films of SiO2 on Si are available from Physical
Electronics for this purpose.  With both neutralizers properly setup and aligned,
most insulating samples will be effectively neutralized, and there is no need for
careful sample masking.
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Section 5:
Types of Acquisitions

In the Acquisition Setup Menu’s pulldown button menu, you can select from
several types of surface analysis data acquisitions: Survey, Multiplex, Sputter
Depth Profiles, Angle Profiles, Maps or Lines.  The purpose of collecting survey
spectra is to determine or confirm the elemental surface composition of the area
being analyzed.  Multiplex spectra have a narrow energy range that encompasses
the peak of interest.  The narrow energy range allows you to optimize either
spectral detail or sensitivity, while keeping the data collection time short.

A sputter depth profile consists of a series of multiplex-type spectra that have
been collected at different depths as material was removed from the sample.  The
purpose of a depth profile is usually to verify or determine the construction of a
thin film structure.  Other applications include studying inter-diffusion of layers,
looking for impurities in layers or at interfaces, and general characterization of
surfaces.

Angle resolved (angle dependent) profiles are used to probe the near surface
region of a sample in a non-destructive manner.  Angle profiles are possible,
because the input lens of the analyzer (SCA) can operate with a small acceptance
angle, and it is possible to tilt the sample in front of the analyzer.

Maps provide a two dimensional display of elemental or chemical state
information.  Maps may provide information that directly leads to the solution of
a problem.  More commonly, maps act as a guide, showing where additional
spectra should be taken.   Lines are typically used in situations where it would be
too time consuming either to collect a map or to determine the sharpness of an
edge or interface.

Survey Spectra
The purpose of collecting survey spectra is to determine or confirm the elemental
surface composition of the area being analyzed.  Since the focus of survey spectra
is to obtain elemental information, the instrumental conditions are adjusted to
maximize elemental sensitivity and not chemical sensitivity (energy resolution).
To accomplish this, survey spectra are typically collected using the highest pass
energy available (187 eV with the Quantum) and a minimal number of data
points (typically 0.8 or 1.6 eV/step).  The sensitivity of the spectrometer
increases linearly with pass energy.
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Another part of the analysis strategy for survey spectra is to use the largest
diameter x-ray probe that is possible, while confining the analysis to the feature
of interest.  With the Quantum, x-ray power increases linearly as the diameter of
the x-ray spot increases.  Time is also a variable in the survey experiment;
however, the quality of the spectrum increases as the square root of time, so it is
very desirable to optimize the other parameters first.

If a survey acquisition has not been previously defined in your Physical
Electronics COMPASS Element Table, open the Transition Editor and create one
as shown and save the setting.  The survey acquisition will now be available as a
push button or setting in the Element Table.

Figure 5-1. Standard survey acquisition parameters entered in the Transition Editor to create a
Survey setting (Su) in the Element Table (Menus -> Acquisition  -> Element Table ->
Transition Editor).
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Prior to starting a survey acquisition, you must first locate and define the
intended areas of analysis.  If “Auto Z” was not used prior to defining the
analysis points, you should open the Properties submenu of the Acquisition
Setup/Control menu and choose to perform a Z-Alignment prior to analysis.

To begin setting up the survey acquisition, push the Su (survey) button on the
Physical Electronics Element Table.  Select the Spectral Acquisition option in the
Acquisition Setup menu and a pass energy of 187eV.  The default data step size
for the 187eV pass energy should be set to 0.8 or 1.6eV/step.  (Use the
Acquisition Setup/Control Properties submenu to view or change this.)  Next
select the largest x-ray spot size that will fit comfortably inside the features of
interest.  For larger diameter x-ray spots, it will take 3-5 minutes to collect an
individual survey spectrum.  When using a small diameter x-ray spot, 15-20
minutes may be required.

After collecting the survey spectra, open the MultiPak software to reduce the
data.  The MultiPak Spectrum window and Periodic Table will display.  For more
detailed information about the use of MultiPak, see the MultiPak Software
Manual.  To open a survey spectrum, press the LastAcq button (which will open
the file most recently acquired) or press the File button in the upper tool bar to
open the file of choice from a File selection menu.

NOTE:  The COMPASS Software menu is called Element Table, while in
MultiPak it is the Periodic Table.

After loading the file, the first task is to identify and label the peaks in the
spectrum.  The most direct way to do this is to press the PeakID button, which
will
1. perform an automatic charge correction based on the position of the C 1s

peak,
2. search its database to identify and label the peaks, and
3. create a push button for each element in the Region bar at the bottom of the

Spectrum window.

After MultiPak has labeled the spectrum, you should verify the accuracy of the
labels using your experience and the Handbook of X-ray Photoelectron
Spectroscopy.  If mistakes were made, you can correct them with one or more of
the software tools that are available.  To remove a label, click on it and drag it
outside the window using the left mouse button.  Another approach to remove an
unwanted peak label is to turn OFF the element in MultiPak’s Periodic Table by
toggling it off with the left mouse button.  To label a peak or element that was
missed by the Auto Peak ID routine, you can turn that element ON in the
Periodic Table by pressing its button using the left mouse button.  This method
will also create a push button at the bottom of the Spectrum window for that new
element.
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If you do not know the identity of a unlabelled peak, you can manually search
through the database of labels.  Using the middle or right mouse key, click on an
open area of the spectrum.  This will display a cursor and list ESCA transitions
that occur at the current cursor location.  With the mouse button still depressed,
you can drag the cursor and search around the area of the unknown peak to see
what elements occur in that energy range.  If you use the right mouse button for
this operation, when you release the mouse button, no labeling will take place.  If
you use the middle mouse button, releasing the mouse button places the current
label on the display at the location of the cursor.

NOTE:  When labeling peaks in this manner, no buttons for the associated
elements will be created at the bottom of the window.  If you wish to add buttons
for elements that were not identified by PeakID, you must create them by
selecting the element from the Periodic Table.

NOTE:  All MultiPak functions are described for a Sun Workstation and not for a
personal computer.

After you have identified the elements that were detected in the survey spectra,
the next step in data reduction is to quantify the results.  Quantification of ESCA
spectra is most accurate when Peak Area measurements are used.  In most
situations, it is recommended that you use a Shirley background subtraction for
making the area measurement.  To  view or change the end points that will be
used to define the background subtraction for a specific elemental peak, press the
button at the bottom of the Spectrum window for that element and the software
will automatically expand the region for that element’s default peak and display
the cursors that are used for background subtraction.  If it is necessary to adjust
the cursors, click and drag the cursor using the left mouse button.  While the
cursor is being moved, a line depicting the background will be displayed to assist
you in positioning the cursor.

NOTE: The default peak is selected in the Transition Editor menu and is usually
the main or major elemental peak.  If you wish to change the default peak, you
can do so in this menu.
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Figure 5-2. Survey Spectrum labeled using the PeakID button in the upper toolbar.  Note, each of the
four elements that have been identified has its own button in the Region Bar near the
bottom of the menu (just above the status bar).
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Figure 5-3. Expanded view of the default oxygen spectra.  The O1s button was selected in the
Region bar to display this.
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Once all the elements have been examined, you can display a table containing the
atomic concentrations of the selected elements by pressing the ACTable button
that is located above the displayed data in the upper toolbar.  To print the AC
Table, in the menu bar select

Display -> AC Table -> Print

For more detailed information about printing and formatting AC Tables, see the
MultiPak Software Manual.

Figure 5-4. The Atomic Concentration Table that displays when the ACTable button is selected.

To print a survey spectrum, press the Print button located in the upper toolbar
above the displayed data.  To select a specific printer or the option to print to a
file, select

File -> Print Setup

from the menu bar and define the desired printer and formatting options.

Multiplex Spectra
Multiplex spectra have a narrow energy range that encompasses the peak of
interest.  The narrow energy range allows you to optimize either spectral detail or
sensitivity, while keeping the data collection time short.

To optimize spectral detail, a low pass energy is chosen (typically 10-30eV) and
the number of data points is increased (0.05 - 0.2eV/step).  There is a temptation
to select a very low pass energy and a very small step size to obtain the “best”
data.  In practice, a compromised choice must be made between experiment time,
pass energy and data step size.  For an efficient, high energy resolution
experiment, you should use as high a pass energy as possible, while still
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resolving the spectral features of interest.  You also want to include the fewest
number of data points possible, while recording an accurate shape of the
spectrum.

To optimize elemental sensitivity, a high pass energy should be chosen (typically
50-200eV) and the number of data points is reduced (0.2 - 0.4eV/step).  Since
sensitivity increases almost linearly with pass energy, it is very advantageous to
use as high a pass energy as possible.

Whether you are trying to optimize spectral detail or sensitivity, you should
select as large an x-ray spot size as possible, while restricting the analysis to the
feature of interest.  This will provide the highest x-ray flux possible to the
analysis area and shorten the analysis time.

Prior to setting up a multiplex acquisition, you must first locate and define the
intended areas of analysis.  If “Auto Z” was not used prior to defining the
analysis points, you should open the Properties submenu of the Acquisition Setup
menu and select to perform the Z-Alignment prior to analysis.

To select elements for analysis, press the button for each element to be analyzed
in the Physical Electronics COMPASS Element Table.  This will define a narrow
energy range for the most commonly used peak for each element.

In the Acquisition Setup menu, select the Spectral Acquisition option.  Select a
pass energy and data step size combination that meets your needs.  (See pass
energy discussion above.)  Select the largest x-ray spot size that will fit
comfortably inside the features of interest.  The required data acquisition time
will be dependent upon 1) the quantity of the element present in the analysis area,
2) the pass energy and 3) the x-ray spot size used and may vary from a few
minutes per element to 30 minutes per element.  The Time that you enter in the
Acquisition Setup menu is the total time for all elements selected.

If you wish to customize the setup of a multiplex acquisition, from the menu bar
of the Acquisition Setup menu, select the “Long” view of the menu.  From this
menu, you can add elements, change the selected peak for an element, modify the
energy range of an element, change the pass energy of a specific element, or
change the number of sweeps for an element.
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Figure 5-5. The “Long Menu” version of the Acquisition Setup menu.  Note, “Short Menu” now
appears in the menu bar, because the Long Menu is displayed, and Stop, rather than
Start, appears because an acquisition is in progress.

You can use this customization capability to optimize an experiment. For
example, if you would like high resolution spectra of a few major elements, you
can select a pass energy of 11.75eV for those elements.  For minor elements
where the interest is sensitivity and quantification, you can select a pass energy
of 93.90eV.  The MultiPak data reduction software is capable of reducing data
files that have mixed pass energies and providing correct quantitative results.
You could also define a higher number of sweeps for elements that are present at
lower concentrations to optimize the acquisition.

When finished setting up the multiplex acquisition, press the Acquire button in
the Acquisition Setup menu.  The spectral data will appear in the Spectral Viewer
window.  To view multiple regions in the viewer, press the Settings button in the
menu bar and select Load.  From the list of files, you can load a setting to display
from one to eight spectra in the Spectral Viewer.

When the acquisition is complete, open the MultiPak software. To open a
multiplex file, press either the LastAcq button (which will open the file most
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recently acquired) or press the File button in the menu bar to open the file of
choice from a File Selection menu.

Initially, all the individual spectra will be displayed on one energy axis, and there
will be a button for each element at the bottom of the Spectrum window (in the
Region bar).  To view an individual element’s spectrum, press the button
associated with that element.

Figure 5-6. MultiPak Spectrum window with C1s selected from the Region bar for display.
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If the objective of the multiplex was focused only on sensitivity and
quantification, it is probably not necessary to massage or print the spectral data.
You should adjust the analysis cursors, so that the background is properly
subtracted (a Shirley background is recommended) and press the ACTable button
to view the results of the atomic concentration calculation.  To print the AC table,
from the menu bar press and drag

Display -> AC Table -> Print

If the focus of the multiplex was to examine the peak shape and position of the
spectra to obtain chemical shift information, there are several software tools in
MultiPak to help with that task.  Before reducing the data in a multiplex, a
smoothing routine may be applied to the data set to improve the accuracy of peak
position and peak area measurements.  A Savitzky-Golay smoothing routine is
recommended, because it does an excellent job of retaining the original shape of
the data curve during the smoothing process.  Depending upon the size of the
data steps in your data and the width of the peaks, a 5-, 7-, or 9-point smoothing
operation is typically used.

To create a preprogrammed Smooth button that displays in the upper toolbar,
press the Process button and select Smooth/Derivative.

Process -> Smooth/Derivative

This will open an Options window.  Using the left mouse button, select the
Savitzky-Golay smooth and the desired number of points to be used for
smoothing.  If you selected 9 points, the Smooth button in the upper toolbar will
read “SG9”.  The smoothing functions operate on the displayed data.  If all of the
data regions are displayed, all of the regions will be smoothed.  If you press the
Smooth button a second time, the data will be smoothed twice.   

The first step in extracting chemical information from a peak is to correct the
energy scale for any shifts that are due to charging.  This is typically done by
looking at the position of the C 1s peak from the hydrocarbon that is present on
most samples.  If the C 1s peak is not at approximately 284.8 eV, it should be
adjusted using the Shift routine.  To open the Shift routine, press the Spectrum
window’s Process button in the menu bar and select Spectral Shift.

Process -> Spectral Shift

A yellow cursor will appear on the screen that you should position with the left
mouse button on the center of the hydrocarbon portion of the C 1s peak.  When
you release the mouse button, the C 1s will shift to 284.8eV (or the position
defined for C 1s in your MultiPak’s Periodic Table database).  If no carbon is
present on the sample, a peak from a matrix element with a known chemistry and
binding energy may be used in place of the C 1s to correct the energy scale for
charge-induced shifts.
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Figure 5-7. Charge correcting the data using the Spectral Shift tool on the C1s peak. The C1s peak
has been shifted to 284.80, which can be read by positioning the cursor on the peak and
reading the value on the right side within the lower Spectral Shift toolbar.

The next step in extracting chemical information is to determine the binding
energy of the peaks for each element.  This can be done in several ways.  With
the peak displayed in the Spectrum window, position the cursor at the center of
the peak.  The location of the cursor is displayed in terms of binding energy and
intensity at the right side of the Spectrum window’s lower toolbar.
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The Peak Analysis function may also be used to determine the binding energy of
a peak.  With the peak displayed in the Spectrum window, press the menu bar’s
Process button and select Peak Analysis.

Process -> Peak Analysis

The Peak Analysis routine will automatically search for the most intense peak in
the displayed data and display a list of information that describes the peak
including its binding energy.  A yellow cursor is displayed where the software
has determined the location of the peak to be.  If you want to change this
position, grab the cursor using the middle mouse button and drag it to the desired
location.  When you have finished moving the cursor, the displayed information
will be updated.

Curve Fit

If the peak of interest contains more than one chemical state, it may be necessary
to use the Curve Fit routine to determine the binding energy of each of the
chemical states.  To perform a curve fit, use the following steps:

1. Make any necessary corrections to the energy scale using the Spectral Shift
routine.

2. Adjust the analysis window cursors, so that an appropriate background
subtraction will be used in conjunction with the curve fit.

3. Press the Curve Fit button.

4. Select the Setup mode, if it is not already selected.

5. Select a Gaussian-Lorentzian peak shape.  (This peak shape is appropriate for
most ESCA peaks.)

6. Define initial bands by pointing and clicking at the desired band position with
the middle mouse button.

7. Readjust the initial band estimates by entering numerical values in the Curve
Fit Setup menu, or drag the flags attached to the currently selected band using
the mouse.

8. Press the Fit button to start the fitting routine.

9. Evaluate the resulting peak positions as shapes using your experience,
reference spectra, and database information.

10. Make any necessary adjustments to the band parameters and Fit again.
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11. When you are satisfied with the results, print the Summary information and
the curve fit spectrum.

12. Press Exit to leave the curve fit routine.

Figure 5-8. The Curve Fit Setup menu shows that four bands have been setup and fit to the C1s
peak.
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Figure 5-9. A Curve Fit of four bands applied to the C1s peak.  The error (in red) follows the baseline
evenly, indicating a good fit.
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The Curve Fit Summary table contains peak position information that can be
used to determine the identity of the chemical state and peak area information to
quantify those chemical states.  For a more detailed discussion of the Curve Fit
software, see the MultiPak Software Manual.

Figure 5-10. The Curve Fit Summary Table pop-up window.

Peak area measurements are typically used to quantify ESCA spectra.  To define
a peak area, push the button for that element and adjust the analysis cursors, if
necessary, for an appropriate background subtraction.  When each element has
been evaluated, press the AC Table button to view the results.  To print the AC
table, press

Display -> AC Table -> Print

To print multiplex spectra, select the element for display in the Spectrum window
and press the Print button.  To tile several of the spectra on a single sheet, you
can use the Publish mode by selecting

Display -> Publish
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Sputter Depth Profiles
A sputter depth profile consists of a series of multiplex-type spectra that have
been collected at different depths as material was removed from the sample.  The
purpose of a depth profile is usually to verify or determine the construction of a
thin film structure.  Other applications include studying inter-diffusion of layers,
looking for impurities in layers or at interfaces, and general characterization of
surfaces.

The setup of the data acquisition parameters for a depth profile is very similar to
that used for a multiplex.  There are concessions to make with time, pass energy
and step size.  You should consider whether you want to sputter the sample prior
to collecting spectra.  The sputtering process may cause some chemical damage
and broaden the peaks.  For this reason, depth profiles are usually collected with
medium to high pass energies (50 - 100eV).  With these pass energies, there is
sufficient energy resolution to observe most chemical shifts, and the higher pass
energies improve sensitivity.

Whether you are trying to optimize spectral detail or sensitivity, you should
select as large an x-ray spot size as possible, while restricting the analysis to the
feature of interest.  This will provide the highest x-ray flux possible to the
analysis area and shorten the analysis time.

In addition to defining the data acquisition parameters for a sputter depth profile,
you must also determine the sputter interval that is necessary to detect the layers
you expect to see.  The parameters you can control for the sputter ion gun
include:

• accelerating voltage (beam voltage),

• ion current,

• the size of the sputtered area, and

• the option of rotating the sample while sputtering (Zalar rotation).

The sputter etching rate of the ion gun can be calibrated by measuring ion current
with the faraday cup and sputtering through a reference film of known thickness.
Reference films of SiO2 on Si and Ta2O5 on Ta are available from Physical
Electronics and other suppliers of surface analysis accessories.

Prior to setting up a sputter depth profile, you must locate and define the intended
areas of analysis.  If “Auto Z” was not used before defining the analysis points,
you should open the Properties submenu of the Acquisition Setup menu and
select the option of performing Z-Alignment prior to analysis.

NOTE:  If you will be using Zalar rotation during the profile, the entire sample
must be within 25mm of the center of the platen.
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Figure 5-11. COMPASS Acquisition Setup Menu with the acquisition type pulldown menu, Time,
energy resolution setting pulldown menu and x-ray setting pulldown menu in the middle
of the menu.

In the Acquisition Setup menu, select Sputter Profile for the acquisition type.
Select a pass energy and data step size combination that meets the needs of the
experiment.  Select the largest x-ray spot size that will comfortably fit inside the
features of interest.

From the Physical Electronics COMPASS Element Table, select the elements to
be analyzed.  If you need to customize any acquisition parameters, select the
Long view from the Acquisition menu and make the necessary changes.

Selecting a depth profile in the Acquisition Setup menu automatically opens a
Sputter Parameters menu.  In this menu, you must define the number of sputter
cycles and how long the sputter interval will be.  You can change the length of
the sputter intervals during a profile by entering the first group of cycles with a
sputter time of “X” minutes and a second group of cycles with a sputter time of
“Y” minutes.  You can stack a series of instructions to customize your depth
profile.  In this menu, you must also select whether you are collecting an
alternating profile or a rotational (Zalar) profile.

Figure 5-12. Sputter Parameters Menu
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Open the Ion Gun menu from the System menu and activate differential pumping
and the flow of gas into the ion gun. A flow number of 50% is typically used.  If
your system has an 11-066 ion gun control, select the desired sputter setting(s).
If the 11-085 ion gun control is used, it should be in the Remote mode and
adjusted for the desired etch rate.

When finished setting up the sputter profile acquisition, press the Start button in
the Acquisition Setup menu.  The spectral data will appear in the Spectral Viewer
window, and the profile will appear in the Intensity Viewer.  To display multiple
regions in the Spectral Viewer, press the Settings button in the menu bar and
select Load.

Settings -> Load

From the list of settings, you can select from one to eight spectra to be displayed
in the Spectral Viewer.

When the acquisition is complete, open the MultiPak software. To open a sputter
depth profile file, press the LastAcq button in the Upper Toolbar (which will
open the file most recently acquired) or press the File button in the menu bar to
open the desired file from a File selection menu.

File -> Open

The depth profile will be displayed in the Profile window, and the individual
spectra will be displayed on one energy axis in the Spectrum window.  There will
be a button for each element at the bottom of the Spectrum window.  To view an
individual element’s spectra, press the button associated with that element.

Depth profiles are usually massaged and displayed in terms of atomic
concentration versus sputter time.  In preparing to quantify a depth profile, we
recommend the following steps be performed:

1. With all spectra displayed in the Spectrum window (no individual region
selected), press the Smooth button (SG5 - SG9) in the Upper Toolbar to
smooth all the individual spectra from the profile.  Smoothing will improve
the accuracy of the peak area measurements by reducing spectral noise and
improving the placement of the endpoints used to define the background
subtraction.

2. Select each element individually by pressing its button in the Region Bar at
the bottom of the Spectrum window, and adjust the analysis endpoints for
background subtraction.

3. Press the AC % button in the Profile window to convert the display’s relative
intensity to atomic concentration.
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The previous steps generate a quantitative elemental depth profile, which may
often meet all your experimental needs.  MultiPak contains additional software
tools, including an LLS Fit Routine that may be used to improve signal-to-noise,
remove peak overlaps, and extract chemical state information from a depth
profile.

Resume Depth Profile

The functionality to allow you to resume profiling after performing other
activities was added with Compass V4.0.  The capability was added as a new
acquisition type. The intention of the new capability was that:

1. An operator could stop a depth profile.

a.  Stopping a profile during sputtering will stop the sputtering. Please note
that the “Stop” button is blue while data is being acquired, and yellow
while the software is waiting for sputtering to complete.

b.  Data will always be taken after a sputter cycle, before the data is saved.

2.  An operator could abort a depth profile.

a. Aborting during sputtering stops the sputtering.

b. No data is saved, but data taken up to this point can be used when the
profile is resumed.

3.  The data and the profile are check-pointed such that, if a crash occurs, the
profile can still be resumed.

4.  The user can continue profiling once all of the original sputter cycles are
completed by adding more sputter cycles.

Note that only the very last profile can be resumed, and that resuming a profile in
the queue is not allowed. Once a profile has been stopped for any of the reasons
given above, the operator can perform any type of acquisition besides depth
profiling anywhere on the same platen being profiled.  It is not recommended that
the operator remove the platen from the stage because there is a 50-µm seating
tolerance for the platen. Once the operator has completed any other activity, the
resume depth profile option can be selected. Selecting the resume depth profile
acquisition type will:

1. Load the state of the last profile performed.

2. Load the sputter cycles from that profile.

3. Load the acquisition parameters.
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At this point, the operator can add new regions to acquire for the profile, or stop
acquiring data for any region where data had already been acquired for the
profile. The number of sweeps or the ratio in the acquisition setup long menu can
be modified for any region that has had data acquired for it. The operator can add
more sputter cycles and modify any sputter cycle that has not been completed.

Once the parameters for resuming the depth profile are set correctly, all the
operator needs to do is push the button marked “Resume,” and the acquisition
will begin where it left off. Data is always taken between sputter cycles.  Note
that any time a different acquisition type is selected, the restrictions and
modification made to resume a depth profile are lost, and the next time you select
resume depth profile, the menu is reset to the state the profile had when it
stopped. Please double-check the parameters in the acquisition long menu
immediately after selecting the resume depth profile type. It is also important to
remember that the neutralization parameters are not saved with an acquisition,
and that the operator is responsible for setting the neutralization parameters
correctly before starting or resuming any acquisition.

Linear Least Square (LLS) Fit

LLS (Linear Least Squares) fitting is a powerful tool that has the ability to
improve detection limits, identify overlapping peaks and extract chemical state
information.  It does this by examining the spectral shapes for an element at user
selected regions of interest in the profile and applying extracted peak shapes to
the data set using a linear least squares fit.

To demonstrate LLS, we will use profile data from a W/TiN/Ti/Si multilayer thin
film structure.  The spectra were smoothed and the analysis endpoints were
adjusted prior to displaying the peak area profile shown.  This data shows a
significant amount of W in the Ti layer, and it is difficult to separate the TiN and
Ti regions.  In an effort to determine if the W in the Ti region is “real” and to
separate Ti from TiN, we will apply LLS.
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Figure 5-13. Depth Profile of a W/TiN/Ti/Si multilayer thin film already smoothed and with endpoints
adjusted.

To begin, press the LLS button in the Upper Toolbar and select W (Tungsten) by
clicking on

• the “W” in the Region bar or

• the W data with the left mouse button.

Then select the regions of interest using the left mouse button as shown.
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Figure 5-14. Regions of interest selected in the W (tungsten) timeline.

Once the regions are defined, you can view the averaged spectrum from these
regions by pressing the Spec/New button (shown on previous menu).  If the
spectra are different and of interest, you can fit the data set with these extracted
component spectra by pressing the Fit button.  When finished with W, press the
Display All button.
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Figure 5-15. Averaged or composite spectra of the areas or regions selected in the W timeline.
Legend: Red=Ti 3p from TiN, White=Ti 3p from Ti, and Green= W 4f.
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Figure 5-16. The LLS results show the region where Ti 3p overlaps W.  Specifically, it is the area of
the graph where the cross-hatched white line overlaps the purple line between 50 and
100 minutes.
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Select Ti as the next element and adjust the regions, if necessary, using the left
mouse button to move region boundaries.  If you wish to turn off a region, double
click on the region boundary with the middle mouse button, which will change
the region boundary appearance from a solid line to a dashed line as shown.

Figure 5-17. Ti Profile region display with regions boundaries adjusted (solid lines) and other regions
turned off (displays as dashed lines).
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Press the Fit button and view the resulting profile regions in the figure below.
When you are satisfied with the results, press the Display All button and exit
LLS.  You will need to turn off the initial region buttons for the elemental data of
W and Ti and any undesired regions, such as the W regions that are really Ti
peak overlaps.  The resulting profile shows a removal of the Ti peak overlap with
W and a separation of the TiN and Ti metal chemical states of Ti.

Figure 5-18. Resulting profile shows the removal of the Ti peak overlap with W and a separation of the
TiN and Ti metal chemical states of Ti.

For additional details about the LLS routine, see the MultiPak Software Manual.
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The LLS routine is very effective at isolating chemical species or peak overlaps
when relatively pure component spectra exist within a sub-region of the depth
profile.  If pure component spectra do not exist within the data set, curve fitting
may be a good alternative for extracting chemical information from the profile.
The curve fit routine in MultiPak allows an entire region of a profile to be curve
fit and the results to be brought into the profile for display and quantification.
For detailed information about curve fitting, see the MultiPak Software Manual.

To output depth profiles, press the File button in the Menu Bar and press the
Printer Setup button.

File -> Printer Setup

Once the Printer Setup menu is correctly configured, it is only necessary to press
the Print button located in the upper tool bar.

There are several options for outputting spectra from a depth profile.  You can
use the buttons at the bottom of the Spectrum window to display all the spectra
from a specific element.  You can, in addition, use the Select Spectra function to
display a subset of all the spectra from a specific element.  You can use the
Publish mode to display a montage plot of the spectra from an element or group
of elements as shown.  See the MultiPak Software Manual for additional
information.

Figure 5-19. Publish mode displaying a montage plot of the Ti 2p spectra.
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Angle Profiles
Angle resolved (angle dependent) profiles are used to probe the near surface
region of a sample in a non-destructive manner.  Angle profiles are possible,
because the input lens of the analyzer (SCA) can operate with a small acceptance
angle, and it is possible to tilt the sample in front of the analyzer.  The analysis
depth at a given angle is defined by the equation: d = 3λ sin θ.  Where d is the
effective analysis depth, λ is inelastic mean free path (escape depth), and θ is the
angle between the sample surface and the analyzer input lens.  Angle profiles are
typically used to measure the thickness or explore the chemistry of very thin
layers.  Applications include the study of chemically modified surfaces,
lubrication, cleaning processes, etc.

The setup of the data acquisition parameters for an angle profile is very similar to
that used for a multiplex.  There are concessions to make with time, pass energy
and step size. Angle profiles are usually collected with low to medium pass
energies (10 - 50eV), because of the interest in obtaining chemical state
information.  If elemental information is sufficient for a specific experiment, the
pass energy could be increased to 100eV or more.

Whether you are trying to optimize spectral detail or sensitivity (count rate), you
should select as large an x-ray spot size as possible, while restricting the analysis
to the feature of interest.  This will provide the highest x-ray flux possible to the
analysis area and shorten the analysis time.

Prior to setting up an angle profile, you must locate and define the intended areas
of analysis.  If “Auto Z” was not used before defining the analysis points, you
should open the Properties submenu of the Acquisition Setup menu and select the
option of performing Z-Alignment prior to analysis.

For an angle resolved acquisition, the sample should be mounted on the AR
Platen.  The AR platen has a raised center portion that allows it to be tilted from
10 - 90 degrees.  When inserting an AR platen into the Quantum, you must select
the Angle dependent platen type in the Platen Information menu and specify a
maximum sample height of 11mm.  If you perform an AR acquisition on a
standard platen, the range of possible angles will be small and dependent upon
the exact location on the platen.

In the Acquisition Setup menu, select the Angle Profile option.  Select a pass
energy and data step size combination that meets the needs of the experiment.
Select the largest x-ray spot size that will comfortably fit inside the features of
interest.

From the Physical Electronics COMPASS Element Table, select the elements to
be analyzed.  If you need to customize any acquisition parameters select the Long
Menu mode and make the necessary changes.
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Selecting an Angle Profile in the Acquisition Setup menu automatically opens
the AR Parameters menu.  In this menu, you define the sample tilt angles and
how long data will be collected at each angle.  The intensity response of the
Quantum varies with the sine of the sample tilt angle.  For this reason, you
should collect data for a longer time at low angles.

Figure 5-20. Angle-Resolved Sub Menu of the Acquisition Menu

When finished setting up the angle profile acquisition, press the Start button in
the Acquisition Setup menu.  The spectral data will appear in the Spectral Viewer
window, and the angle profile will appear in the Intensity Viewer.  To display
multiple regions in the Spectral Viewer, press the Settings button in the Menu
Bar and select Load.  From the list of files, you can select from one to eight
spectra to be displayed in the Spectral Viewer.

When the acquisition is complete, press the Reduce Data icon in the Main
Control menu to open MultiPak. To open an angle profile file, press the LastAcq
button (which will open the file most recently acquired) or press the File button
in the Menu Bar to open the desired file from a File selection menu.
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Figure 5-21. MultiPak Spectrum window

The angle profile will be displayed in the Profile window and the individual
spectra will be displayed on one energy axis in the Spectrum window.  There will
be a button for each element at the bottom of the Spectrum window.  To view an
individual element’s spectrum, press the button associated with that element.
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Figure 5-22. MultiPak Profile window

Angle profiles are usually massaged and displayed in terms of atomic
concentration versus SINθ.  In preparing to quantify an angle profile, Physical
Electronics recommends the following steps be performed:

1. With all spectra displayed in the Spectrum window (no individual region
selected), press the Smooth button (SG5 - SG9) to smooth all the individual
spectra from the profile.  Smoothing will improve the accuracy of the peak
area measurements by reducing spectral noise and improving the placement
of the endpoints used to define the background subtraction.
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2. Select each element individually by pressing its button at the bottom of the
Spectrum window and adjust the analysis endpoints for background
subtraction.

3. Press the AC % button in the Profile window to display relative intensity
versus atomic concentration.

Figure 5-23. MultiPak Profile window showing the atomic concentration of each element over the
range of angles.
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The previous steps generate a quantitative elemental angle profile.  MultiPak
contains software tools that may be used to improve signal-to-noise, remove peak
overlaps, and extract chemical state information from an angle profile.

One MultiPak tool that has the ability to improve the signal-to-noise ratio,
remove peak overlaps and extract chemical state information is LLS (Linear
Least Squares) fitting.  It does this by examining the spectral shapes for an
element at user selected regions of interest in the profile and applying extracted
peak shapes to the data set using a linear least squares fit.  The LLS software is
applied to angle profiles in the same manner it is used for sputter profiles.  For a
detailed discussion about LLS, see the Sputter Profile portion of this manual or
the MultiPak Software manual.

The LLS routine is very effective at isolating chemical species or peak overlaps
when relatively pure component spectra exist within a sub-region of the angle
profile.  If pure component spectra do not exist within the data set, curve fitting
may be a good alternative for extracting chemical information from the profile.
The curve fit routine in MultiPak allows an entire region of a profile to be curve
fit and the results to be brought into the profile for display and quantification.
For detailed information about curve fitting, see the MultiPak Software manual

To output angle profiles, press the File button in the Menu Bar and press the
Printer Setup button.  Once the Printer Setup menu is correctly configured, it is
only necessary to press the Print button located below the Upper Toolbar.

File -> Printer Setup

There are several options for outputting spectra from an angle profile.  Use the
buttons at the bottom of the Spectrum window to display all the spectra from a
specific element. In addition, you can use the Select Spectra function to display a
subset of spectra from a specific element.  You can use the Publish mode to
display a montage plot of the spectra from an element or group of elements.  See
the MultiPak Software manual for additional information.

Maps
Maps provide a two dimensional display of elemental or chemical state
information.  Maps may provide information that directly leads to the solution of
a problem.  However, maps also acts as a guide, showing where additional
spectra should be taken.

Maps consist of an array of individual pixels.  With the Quantum, a complete
spectrum is collected at each pixel.  These spectra are collected in what is called
an “unscanned” mode.  That is, the entire spectrum is collected in one step like a
snapshot, which greatly reduces the time required to collect a map.  The
unscanned spectra contain 16 data points, one from each detector channel.  The
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width of the spectrum will be 13.6% of the pass energy being used to collect the
data.  If a pass energy of 187.85 is used, the energy width will be 25.6eV
(1.6eV/channel).

Maps should be collected using the maximum pass energy of 187.85eV, because
of the large number of data points and the need to collect data with a good signal-
to-noise ratio in a short period of time.  The x-ray spot size should be as large as
possible.  Use a spot size that matches the average-sized feature that you expect
to see in the map.  With the minimum x-ray spot size of 10µm, a map for a major
element will require an acquisition time of 5-10 minutes and for a low
concentration element 20-60 minutes, depending upon its concentration and
relative elemental sensitivity.  If a larger x-ray spot size is used, the acquisition
times will be shortened.

Prior to setting up a map, you must locate and define the analysis area.  For
imaging acquisitions, it is especially important that you be at the focal point of
the x-ray and analyzer optics.  The Auto-Z function should be used to find the
focal point prior to defining areas to be imaged.  (The Auto-Z function is part of
the COMPASS Imaging menu.)

In the Acquisition Setup menu, select the Map option.  Select a pass energy of
187.85eV.  Select the x-ray spot size that matches the features of interest.  Define
an acquisition time that takes into consideration the x-ray spot size being used,
the concentration of the element being mapped, and the relative sensitivity of the
element.

From the Physical Electronics COMPASS Element Table, select the element(s)
to be mapped.  If you need to customize any acquisition parameters, select the
Long Menu mode and make the necessary changes.

When finished setting up the map acquisition, press the Start button in the
Acquisition Setup menu.  The spectral data will appear in the Spectral Viewer
window, and the map will appear on the video monitor.

When the acquisition is complete, press the Reduce Data icon in the Main
Control menu to open MultiPak and to close the COMPASS Acquisition and
Spectral Viewer menus. To open a map file, press the LastAcq button (which will
open the file most recently acquired) or press the File button in the menu bar to
open the desired file from a File Selection menu.

The unprocessed map will be displayed in the Map window, and an averaged
spectrum will be displayed in the Spectrum window.  Due to the large number of
spectra that are stored in a map file, it may take a few moments to load the file,
especially if the file contains maps for multiple elements.  When all the spectra
have been loaded, a background correction will be made based upon the location
of the analysis cursors.  The map display will be updated with the newly
calculated peak measurement information.



5: Types of Acquisitions

Quantum Operator’s Guide 5-36

The first step in data reduction of a map is to adjust the analysis cursors in the
Spectrum window for a proper background subtraction.  Each time you make an
adjustment with the analysis cursors, the map will be redrawn using the newly
calculated peak measurement values, if the DataLink is on.  If the DataLink is
off, press the Img/Upd button to update the image after you have made your
changes.

Figure 5-24. Map (left) with brightness/contrast bar (right) before any massage.
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Brightness Control and Contrast Stretching

The next step is to adjust the brightness and contrast using the software handles
on the color bar to the right of the map.  Brightness is adjusted with the left
handle and contrast is adjusted using the two handles on the right side of the
color bar.  The left mouse button is used to click and drag the handles.  After
making a contrast adjustment, the contrast handle will be displayed in an unfilled
or outlined mode.  When you are finished adjusting the contrast, you will need to
close (resolve) the contrast operation by clicking on the handle with the middle
mouse button.  The contrast handle will be displayed filled in.

Performing a contrast stretch will improve the appearance of most maps.  For
monotone displays (shades of green, blue, red or white), drag the lower contrast
handle up to eliminate noise pixels in black areas, then drag the upper contrast
handle down until the features of interest begin to saturate as indicated by their
bright color during the contrast adjustment.

From the Color Display pulldown menu in the Lower Toolbar (“gray” button),
you can select

• a gray scale display mode,

• a color display using a combination of black with red, green, or blue, or

• one of two color contour modes that associate a color scheme with the peak
intensities being displayed.

Additional data massage tools are available for improving the signal-to-noise
ratio of a map and for extracting chemical information from ESCA maps.  To
improve signal-to-noise, there are several mathematical filters available in
MultiPak.  The most commonly used filter is a 3x3 point map smooth (Smo3x3).
A 3x3 smooth followed by a contrast stretch will enhance the appearance of
many maps.  For detailed information about the filter routines, see the MultiPak
Software Manual.
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Figure 5-25. Map after smooth and contrast stretch.  Select the “gray” button to change the color
display.

Center of Gravity (COG)

To extract chemical information from a map, you need to make an educated
guess about where the areas containing different chemistry are.  A tool called
COG (center-of-gravity) is available to help you find areas with different binding
energies in a map.  To use the COG tool:

• Select the spectrum for the desired element using the element buttons in the
Region bar of the Spectrum/Map window.



5: Types of Acquisitions

Quantum Operator’s Guide 5-39

Figure 5-26. Map before Center of Gravity (COG ) routine.

• Click on one of the analysis cursors with the right mouse button to open the
Analysis Region Properties submenu.

• Open the Intensity Type pulldown and select COG.

• Select Apply or OK with the left mouse button.

• The COG routine will look at the spectrum associated with each pixel of the
map and determine the binding energy centroid of the most intense peak of
the spectrum.
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Figure 5-27. Analysis Regions Properties submenu

The map will be displayed with low binding energy pixels as black and high
binding energy pixels as being white or bright.

If there are areas of significantly different binding energy present in the map,
they will appear in the COG display of the map.  The LLS (linear least squares)
fitting routine may then be used to extract reference spectra and apply a LLS fit
to the map.



5: Types of Acquisitions

Quantum Operator’s Guide 5-41

Figure 5-28. Map after Center of Gravity (COG ) routine.

Linear Least Squares (LLS) Fitting

To apply the LLS routine:

• Select LLS from the  in the Map window.

• Use the left mouse button (click and drag) to select rectangular areas of
interest.
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Figure 5-29. LLS Area Definition: Two LLS areas were defined, the green region on a darker region
and the pink region on a lighter region.
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• Press the Spec/New button in the lower toolbar of the Map/Spectrum window
to view the composite spectra created by adding the pixels contained within
each selected area.

Figure 5-30. LLS Spec/New—For each area, a composite spectrum of the pixels within that area was
created.

• If the composite spectra appear to be useable as reference or component
spectra for an LLS fit, press the Fit button and view the results in the Map
window.  If necessary, redraw the areas and re-examine the composite fit
using Spec/New.
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Figure 5-31. LLS results—Original map after COG massage showing areas selected for composite
spectra above Image 1 where composite spectra 1 is highlighted and Image 2 where
composite spectra 2 is highlighted.

• If the results are acceptable, exit the LLS routine.  The newly generated
chemical maps will be displayed in the Map window.

• Contrast stretch the new maps as necessary.
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Figure 5-32. LLS massaged data after Contrast Stretching.  NOTE:  The Region bar has two new
buttons in it, entitled C1s.ls1 and C1s.ls2.

Maps may be printed—using color or black and white printers—individually or
in groups by selecting the Tile option at the top of the Map window.
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Lines
Lines provide a two dimensional display of elemental or chemical state
information.  Lines are typically used in situations where it would be too time
consuming either to collect a map or to determine the sharpness of an edge or
interface.

A line is a single row of pixels or data points.  A complete spectrum is collected
at each pixel.  These spectra are collected in what is called an “unscanned” mode.
That is, the entire spectrum is collected in one step like a snapshot, which greatly
reduces the time required to collect a line.  The unscanned spectra contain 16 data
points, one from each detector channel.  The width of the spectrum will be 13.6%
of the pass energy being used to collect the data.  If a pass energy of 187.85 is
used, the energy width will be 25.6eV (1.6eV/channel).

Lines are often collected with a pass energy of 187.85eV, because of the large
number of data points and the need to collect data with a good signal-to-noise
ratio in a short period of time.  Use a spot size that is similar in size to the
features you expect to see in the line.  With the minimum x-ray spot size of
10µm, a line for a major element will require an acquisition time of
approximately 5 minutes and for a low concentration element 20-60 minutes
depending upon its concentration and relative elemental sensitivity.  If a larger x-
ray spot size is used, the acquisition time will be shortened.

Prior to setting up a line, you must locate and define the analysis area.  For
imaging acquisitions, it is especially important that you be at the focal point of
the x-ray and analyzer optics.  The Auto-Z function should be used to find the
focal point prior to defining lines.  Lines may be drawn at any angle from
horizontal to vertical.

In the Acquisition Setup menu, select the Line option.  Select the desired pass
energy.  Select the x-ray spot size that matches the features of interest.  Define an
acquisition time that takes into consideration the x-ray spot size being used, the
concentration of the element, and the relative sensitivity of the element.

From the Physical Electronics COMPASS Element Table, select the element(s)
of interest.  If you need to customize any acquisition parameters, select the Long
Menu mode and make the necessary changes.

When finished setting up the line acquisition, press the Start button in the
Acquisition Setup menu.  The spectral data will appear in the Spectral Viewer
window, and the line data will appear in the Intensity Viewer window.

When the acquisition is complete, press the Reduce Data icon in the Main
Control menu to open MultiPak and close the Acquisition, Intensity Viewer, and
Spectral Viewer menus.  To open a line file, press the LastAcq button (which will
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open the file most recently acquired) or press the File button in the Menu Bar to
open the desired file from a File Selection menu.

File -> Open

The unprocessed line will be displayed in the Profile window, and all the spectra
from the line will be displayed in the Spectrum window.  When all the spectra
have been loaded, a background correction will be made based upon the location
of the analysis cursors.  The line display will be updated with the newly
calculated peak measurement information.

The first step in data reduction of a line is to adjust the analysis cursors in the
Spectrum window for each region for a proper background subtraction.  Each
time you make an adjustment with the analysis cursors, the line will be redrawn
using the newly calculated peak area values.

Line data may be reduced and displayed in the same manner as a depth profile.  It
is possible to smooth, quantify, curve fit or use LLS fitting on line data.  For
details of these operations, see the Sputter Depth Profile section of this manual or
the MultiPak Software Manual.



5: Types of Acquisitions
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